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Choose Default Environment Settings

=2

l.li:r?sd'r' _
O Visual Studio 2010 Utimate

Before you begin using the application for the first time, you need to specify the type of development
activity you engage in the most, such as Visual Basic or Visual C#, This information is used to apply a
predefined collection of settings to the development environment that is designed for your

development activity.

settings selected below.

Choose your default environment setti

You can choose to use a different collection of settings at any tire. From the Tools menu, choose
Import and Export Settings and then choose Reset all settings.

[¥] Migrate my eligible settings from a previous version and apply them in addition to the default

| || General Development Settings

Description: |

i Sy
Yisual Basic Development Settings
Visual C# Development Settings
Visual C++ Development Settings
Visual F# Development Settings
Web Development

Web Development (Code Only)

Start Visual Studio Exit Visual Studio

Please select one of the collections of settings from
the list.

Metd tnv €ykatdotoon Tou
Visual Studio (VS) tnv mpwtn
dopad mou Ba Eeklviooupe TO
VS oto mapdBbupo umodoxnig
eTAEyou e General Settings.



©o Start Page - Microsoft Visual Studio 25 X
File Edit View Debug Team Data Tools Architecture Test Analyze Window Help
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Start Page X ~ Solution Explorer ~ I X

Microsoft* " 1 1
QO Visual Studio 2010 Utimate Erntecta otnv  apxn
| KAOe véou project

g : - Get Started =~ Guidance and Resources ~ Latest News ,
’I_?_l Connect To Team Foundation Servet ET[LA.EVO U us N EW

) Welcome Windows Web Cloud Office SharePoint Data
E] New Project... )17 .
[ Project.

[} Open Project. Tnimroee ¥ What's New in Visual Studio 2010
Learn about the new features included in this release.

Xx0q|0o] . s210]dx3 AA1S e

Visual Studio 2010 Overview
What's New in .NET Framework 4
2 Ergasies Customize the Visual Studio Start Page

Recent Projects

Convection-Diffusion
Ergasies
Close page after project load

Show page on startup Creating Applications with Visual Studio

Show output from: ‘File Generation 'i | @ | @D ==
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File Edit View Debug Team Data Tools

Architecture  Test
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Analyze Window Help
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Recent Projects

; Ergasies
Convection-Diffusicn
Ergasies
Close page after project load
Show page on startup

Output

Show output from: | File Generati

ﬁ; IR (=] Output

-l ° Type here to search

MNew Project
Recent Templates
Installed Templates

Visual Basic
Visual C#
Visual C++
Visual F#
4 Intel(R] Yisual Fortran
irary
QuickWin Application
Windowing Application
COM Server
Other Project Types
Database
Medeling Projects

Test Projects

Online Templates

MET Framewaork 4 ¥ Sort by: Default

2 B | 3

Empty Project

—_—

Intel(R) Vis

Main Program Code

Intel(R) Visua 4

Name: Homework1|

3-4

Mo kwdika o€ fortran
ETUAEYOU UE OTNV KOPTEAQ Intel
Visual Fortran — Console
Application.

Empty Project.

Atvoupe KatdAAnAo ovopua oTo
project.

KaAo elval va amoBnkevoupe
oto Default ¢pdkelo,
TOUAQXLOTOV yLaL apxh).
Adnvoupue xwpic emtAoyn to:
Create directory for solution.
KaAo ival va amodelyoupe
eAANVIKOUC, L6LKOUG
XOPOAKTAPEG KOl KEVAL.

Locatic. ..

C\Users\Masteruser\DocumentsiVisual Studio 20104 Projects',

Selution name: Homework1

Browse...

5 |

[ ] Create directory for solution ]

|| Add to source control




o0 Homeworkl - Microsoft Visual Studic
File Edit

Mew Folder
Unload Project
Set as StartUp Project

Intel Inspectar XE 2013 Project Properties
Intel VTune Amplifier XE 2013 Project Properties
Intel Advisor XE 2013 Project Properties...

[ RRCRE

Properties
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Output

Show output from: | File Generation

FIEETE IS

ﬂ; IR (=] Output
Creating project 'Homework1'... project creation successful,

£ Type here to search

To project €xeL dnuovpynbel
Kol EUKOAQL EAEYYXETAL KAl OO
Tov avtiotolyo $pakelo ToU
TO amoOnKeVOAE.
ErttAéyou e amo TNV KapTEAQ
Project-> Add New Item,
TIPOKELMEVOU va  dTLaEou e
gva apyeio (rmy .f90 n .txt)
aro tnv apxn (AnA. to apyeio
QUTO Oev TPOUTIAPYEL).

Av to apyeio npolmapyeL oTo
ddkedo Ttou Project, tote
ermAéyoupe Add  Existing

ltem.

BonOntikot  kwdlkeg OV
TIEPLEXOUV UTTOPOUTLVEC
anapaitnTeg yLa 10

Mpoypapua, Ba TmpEmeL va
npootebolv  oto  Project
HEOW TWV Bnuatwv 2 1 3.

Solution Explorer = 3 X

g Solution "Homewerk1
v ﬁ Hemework1
3 Header Files
1 Resource Files
3 Source Files

£ >
EE

p o ]
Homework1 Project Pr -
= 2h| =l

w

(Mame) Homeworkl
Project F C:\Users\Mas]

(Name)
Mame of the project.
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File Edit View Project Build Debug Tearmn Data Tools Architecture Test Analyze Window Help 1. npOKELuE’VOU Va d)-cl,dgou ue apXE(.O Vl.a
- S % @]9 - -85 b [Debug -| [ winz2 -1 | ' !
T ITE - V-0 yvrrommssrmemms kwoka fortran, emAeyoupe fortran free-

Installed Templates Sortby: Defauit ™ form file.f90.

e
;_n 'iF°“’a""’°Je“ 1 mre— K2 I'IpOKs-:L'uévou va cllmdﬁou e a'pxs'Lo
s A Sedopévwy .dat, emAéyoupe text file.txt
g Heade Fle () KOL MITOPOUME va aAAAEOUUE KAl TNV
il e i) ETEKTOON TOU apxelou o€ .dat
Resource il (rg 3. AmoOnkeboupe TO véEa opxela e
2 [ e KaTAAANAO Ovoua oto ¢pakeAo Tou project.
4. TMpoooxn! Ae xpelaletal allayn to path
N¢ anoBnkevuonc. Av €xel ¢TLaytel cwotd
10 Project, Ba eival nén oto ddakeAo toU
Output Project.
Showouptiors s ooneth — 5. OAa ta apyela mou xpeldlovtal ywa va
Location: C:\Users\Masteruser\ Documents\Visual Studia 2010\Projects\ Tpéﬁst 0 K(bGLKa(; Ba T[péT[El Vol UT[deOUV
otov ¢akelo Ttou Project, mpw ToOV

TPEEOVUE.

ﬁ; IR (=] Output
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o0 Homework] - Microsoft Visual Sty

File Edit View Project Build
e RaARGr= ™ - B e

O b A S| =] =

Homeworkl.f30

“1% (Global Scope)
1 FIPROGRAM HOMEWOH

[%e]
m
2
i}
E 2 IMPLICIT N
g 3 INTEGER:: |
- 4 REAL(8)::PH
¥ 5 REAL(B), A
g‘ 6 REAL(B), A
5 7 INTEGER, A
2 sl |1
9 OPEN(1,FILH
1@ OPEN(2,FILH
i
12 NNODE=. .
138 [ !
14 ALLOCATE(A
15 IMAIN PROGH
16 IFEM
17 CALL LINEAR
18 CALL ARROW
190 [!  POST PROCE]
28 WRITE IN F1l
210 [ !
22 CONTAINS
230 | !
24| E SUBROUTINE
25

26 END SUBROUT
ENDPROGRAM HOMY

Output

Show output from: |Fi|e Genera

ﬁ; IR (=] Output
ltem(s) Saved

£ Type here to sear

AkoAouBwvtag ta mponyovpeva BrApata
dtatape Eva apyxeio Homework_1.f90 oto
oTtolo UmopoUE va ypAYPou e Tov KwoLKa
TIOU €TILOU MOV UIE.

Input/Output apxela Ba mpooteBolv OMwg
g&nyeital mapandvw.

to 6e€la mapaBupo (Solution Explorer)
UTTopw va €xw oca apyeio adopouv To
Project.

Ao ebw pmopw va aAAdlw to Input apyeio
Kal va PAEnw Ta amoteAéopato ot
output. (Me SUTAOG KALK TO apXelo avolyel
oTa OPLOTEPA).

Mpoomnabwvtac va BAAw KAMOLO apXeio
TUmou .dat mou Adn umapxeL oto dakeAo
Tou project, oto mapdBupo nou Ba avolitel
npwta eriAéyw all files (*,*) kat otnv
ouvexela Paxvw Tto apyeio.

Ot aplBpot Twv ypappwyv pdavidovral wg
e€nc: Kaptéla Tools — Options — Text
Editor Languages — General:
Display Line Numbers.

—All

7~

I3 This PC
¥ 3D Objects
I Desktop
%] Documents
J Downloads
. b Music

| Pictures

[ videos

&, System (C)

=¥ Network

_I o0 Add Existing ltem - Homewaork1 X

Organize Mew folder = O @

~
@ OneDrive - MANEI

= Btion 'Homework1' (1 projec

Homewaork1

"1 Header Files

1 Resource Files

— Source Files
Homework1.f30

N\

< Projects » Homeworkl » v | B Search Homework1

Name Date medified

Debug
=] Homewaork1.f0

v <
File name: ||

5 3 Common Itel () Visual Fortrar >

porr Cancel




o0 Homeworkl - Microsoft Visual Studic

File Edit View Project Build Debug Team Data Tools

e parnigea= - §

P b A IR E

Homeworkl.f30

“1% (Global Scope)
1 FIPROGRAM

3 INTE

¥0Q|00] . J2iojd¥g RaRg a

Build Solution

Rebuild Solution

Clean Selution

Build Solution for Intel Static Analysis...
Rebuild Solution for Intel Static Analysis...
Build Homewerk1

Rebuild Homewaork1

Architecture Test Analyze Wing

Ctrl+Shift+B

Ertthéyovtag Compile amo tnv kaptéAa Build Ba
BpoUUE T CUVTOKTLKA AAON Tou KWOLKAL.

2to output mapaBupo sudavidovrtol ta Adbn, pla
TepLlypadr] TOUC KOL 1 YPOLLUN TTOU €XOULE TO
AdBoc. Zuvnbwc SLopBwvou e To MPWTO Kol
TIPOXWPAE OTA ETIOUEVA, TIPWTO OUWC
¢avakavovtag compile.

‘Exovtac dtopBwoel OAa ta AdBn (0 errors, 0
warnings), armo tnv ibta KAPTEAA LLE TIPLV, KAVOULE
build solution, wote va dnuloupynOei to apyeio
.exe oto pakeAo debug.

JTn oUVEXELa amo TNV KapteEAa Debug emAéyou e

uild | Debug | Team Data Tools Architecture Test Analyze Windoj Sta rt debugging’ (bote to npévpauua Va

4 REAL 3
5 REAL Clean Homework1 .
6 REAL Project Only
7 INTE : : :
sl |1 Build Homewaork1 for Intel Static Analysis...
9 OPEN Rebuild Homework1 for Intel Static Analysis...
1@ OPEN X
0 | Batch Build...
12 NNOD! Configuration Manager...
13 ! I° .
0 a 1 Q Compile Ctrl+F7
14 )
15 L R 4'
16 'FEM -
ual Studio
17 CALL LINEAR(...)
18 CALL ARROW(...)
*~8 |1  POST PROCESSING 3 Windows b
2 WRITE IMN FILES.. ) Start Debugging F5
Start Without Debugging Ctr|+F-5
Output B Start Performance Analysis Alt+F2
errompETTET=r BT e [ AtachtoProcess.
compilation aborted for C:i\Us{IT N - S G
:?- [y °F Stepinto Fi1
Build log written to "file:/ Sj”ﬁ [;3 Step Over F10
Homeworkl - 11 error(s), @ wal,’
B). A Toggle Breakpoint F9
ER, &
Mew Breakpoint 3
""""""""""" Done -4 Fril Delete All Breakpoints Ctrl+Shift+F9
[2,FIL _ .
Clear All DataTips
| NIGIREEY (=] Output . Export DataTips ...
e (a Import DataTips ...
PROG Options and Settings...
£ Type here to search  nesn. )
BEOLI A

OTOLUOTACEL, €AV UTIAPXOUV Kal AAAa AaOn.

Homeworkl'\Homeworkl.f98 (code 1)

lects\HomeworklyDebugiBuildlog. htm"

Ch 38

AT T
R ot BN 3/7/2021 ~




o0 Homeworkl (Debugging) - Microseft Visual Studio

File Edit View Project Build Debug Team Data Tools

IR SR R A | u‘j| & 53 _E.l") -~ ';.'::'"__;'1;| P |Debug Win32

i B A

2I0PPBeB3EBAru@aly>=E

Process: |[?136] Homeworkl.exe

'| Thread: |[129?2] Main Thread '| V W Stack Frame: |Homeworkl.exelH

Homeweorkl f90

Architecture  Test Analyze Window

Help

% | @ |Hx 5[~

| (3 |write(12

“i (Global Scope)

-| i HOMEWORK1

15
16
17 IALLOCATE(A,B,X,...)
1¢ 3 'MAIN PROGRAM
1< 1 EEM
@ 20 A=A+1.8D8 ]
- e i
22 ICALL ARROW(...)
23 ! POST PROCESSING
24 ! WRITE IN FILES....
25 !
26 CONTAINS
0% -
4
Ma 1] Type >
A -8.2559631345317830+061 % - REAL(B)
‘aamcasenoancean
Local 5 0
ame a1 Type
-9.2550631349317830+061
B - Tl wat &g PHI fod 3 = REAL(E)
i) -858993460 % -| INTEGER
& | -858993460 % -| INTEGER
g CONN Undefined pointer/array ‘4 +| INTEGER
/o Type here to g AL Undefined pointer/array 3, ~| REAL(8)
@ B Undefined pointer/array % -| REAL(8)
il X Undefined pointer/array % = REAL(8)

F Locals B= RUE SR

Ztnv npaén mMoAAEC GopEG Eva MPOYPAUA TIOPOAO
Tmou Oev €XEL OUVTOKTIKA AAOn Kol ekteAeital
Kavovika, ev Byalel owota anoteAéopata (NaN,
infinity kAm).

Ekel kKaAoUpaoTE WG pnXovikol va Bpoupe Aoyka
AGBn tou TMPOYPAUUATOC HOC, TO omoia GuaLlkd
Kol 8ev pmopel va ta E€peL n Fortran.

Av Bfhoupe vo eléyéoupe TNV pon  TWV
UTTOAOYLOHWV HOG YPOUUA-YPOUUN UTOPOUUE Vo
Baloupe €va break point ota aplotepd ToOU
aplBpol ™G ypopuNG (He amAd KAWK) Kal va
EKTEAECOUUE TO TpoOypappa pe debugging. H
EKTEAECHN TOU TIPOYPALUATOC Ba OTAMATHOEL OTO
break point (kokkwvo onueio).

Jto TnapaBupo watch 1 pumopoupe va
TIANKTPOAOYIOOUE TO Ovopa omolacdnmote
HeTaBANnTA¢ (kaBe eiboug) kal Ba pag yuplosl tnv
TLUA TNG MEXPL TO OnUElo TOU €XEL EKTEAEOTEL O
Kwdkag. 2to TpéXov mapddsypa BAEnMw OTL n
HETABANT A €xeL Amelpn TR, Apa  OTOLEG
npatelg yivouv napakdatw dev Ba dwoouv cwotd
anoteAéopata. Omote S0pBwvw KATAAANAQ TLG
T(PONYOUHEVEG YPAHHEG.

Ztnv kaptéAa Locals tng meploxng 4 pag divovrat
OL TLLEG OAWV TWV TOTUKWV HeTAPBANTWY. (ESw Sev
UIOpW VA TANKTPOAOYNOW KATL).

TENOG, UMAPYOUV  TIEPLOOOTEPEC  ETUAOVEG.
Napadelypatog xapn, matwvrag F11 n ektéleon
TOU TIPOYPAUMATOC HETA TOo break point yivetal
YPOUUN-YPApUN (KITpvOo BEAOG L YPOLUU KOTW).
AN\N emdoyn €lval to umo ouvBnkeg break point
(Conditional break point).
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’ s
1. Exovtag evepyomolnupevo 10
’ ’
dUAO Tou emBupovpe va
r [
| ELCAYOUUE TO OMOTEAECHATA
@l OriginPro 8.5 - CA\Users\Masteruser\Documents\OriginLal SAUNTITLED - /Folderl/ , , ,
File Edit View Plot Column Worksheet Analysis nage Tools Format Window Help Evoq Kw& LKa’ ST[LAEVO U lJ‘E :
Ol New.. N | i q e = BE| &
= EE BEm =V (=] ..U [ . .
& gpen. Cire0 File—Import — Import Wizard.
&5 Open Bxcel... Ctrl+E v ’ ’
B oz, Gl | (H evaMoktka  amo v
Close -
c Single ASCH = ' %)
E Save Project Ctrl+5 Multiple ASCII J A GU VTO lJ'E U 0 r] TO U
Save Project As... Comma Delimited (CSV)... ! 'E
——— et 2. Ito mapaBupo mou Ba avolel
Save Template As Sgund (WAV)... [ 1 [
Template As... EVIOTILCOVLE TO APXELO TIOU ELval
Save Workbook As Analysis Template... Image... ’ ’
Save Project As Analysis Template... NI DIAdem (DAT)... Va KaVO U IJ.E I m po rt aT[O TOV
& print.. Ctrl+P PIIRLAI (ALY, T ! ! ( ' !
e e DA avtiotolyo dakelo (edbw Ba eival
Page Setup... pCLAMP (ABF, DATAB?)... 4 ! !
0 GAKENOC TTOU EXOULE TPEEEL TOV
I c: 0% 0% DXL K. :
Export » Thermo (SPC, CGM)... y KW LKOL) .
Batch Processing... Princeton Instruments (SPE)... —” 3 )
Database Import 4 Data Translation (DCF, HPF)... @
Re—lmport Directl)r Ctrl+4 Famos (DAT, RAW]... File Edit View Plot Column Worksheet Analysis Statistics Image Tools Format Window Help
R ETAS INCA MDF (AT, MDF).. O T LI =6 B2 4 JERe
Somat SIE (SIE]... Wl A R \
Recent Imports 3 _.oma sB i 4 PR Jj S~ [0 w0
Recent Exports b Binary 2D Array... k| @ unTmED Impert Wizard - Source T x
CDF (CDF)... {23 Folderl
Recent Books 4 EDF(EDF, BDF)... Data Type
Recent Graphs 3 EarthProbe (EPA) + (® ASCl ) Binary () User Defined 2
Recent Projects 4 HQF_S (H5, HES, I-I|II£JF5)... (l;t;Snur‘cs
Exit fle -
! NgtCDF (NCJ'” () Clipboard
< > IgorPro (PXP, IBW)... Import Fiter
/ o oo . - @ - % v T SigmaPlot (JNE).. [¥] List fitters applicable to both Data Type and file name
—— KaleidaGraph (QDA)... ; — ImDurt.Hhersfur:urrent Data Type | <Mone> ~ e
Matlab(Mat)... ' /. EBWH Description ‘ ‘ AT
£ Type here to search Minitab (MTW, MP)... | = Target Window ENG 72001
@‘ Worksheet Matrix Mone {User Defined filter needs to create window|
Template <Default> ~
Template could be used only when import mode is start new books or start new sheets
Impaort Mode | Replace Existing Data
<« Back Mext>» Finish 12

Radian

&




1. Em\éyoupe to apxeio mou B€éAoupe kal otn
ouvéxela add file—ok. ZIta emopeva
napdBupa next [ aneuvBeiag finish.

6] OriginPro 8.5 - C:\Users\Masteruser\DocumentshOriginLab\85\User Files\UNTITLED - /Folderl/ 2 AV EXEL VLVEL 1o Import o.wo.tal ea T[pET[EL va
File Edit View Plot Column Worksheet Analysis Statistics Image Tools Format Window Help BAE'T[Q) T anorsAéo‘ua‘ca éan Ei_val_ vpauuéva I
DERBD 2 PEEEE aEE (W[ 870 B3 &[IB2e|  auoto apxeio.
e e K Hj BocautcA -0 V|BEIU=x S ALE-M-A||2-2- 50 |3, Mopatnpiote nwg T0 GUANO HETOVOUAOTNKE |
f Q3 unTmep - ot Wizarg | © ™ot Multiple ASCI X avtopata ano sheetl oe METRISEIS.
mport Wizard - , , , , ,
& | -3 Folder _ : 4. Ebw pe 6e€l kKA avw oto ovopa tou dpUAAOU,
2 o | e L MR d - R TIOPW VO TO METOVOMAOW KATAAANAQ f va
4+ ® Ascll MName ” Date modified u p , 'IJ' u s n ’n
. Data Source | 1| METRISEIS.DAT oo npooBéow oto idLo workbook kat dAAo pUANo.
: o [ | 9|8
h () Clipboard
}i Import Fiter
E - r - ? ChUsers\Masteruser\Documentsh OriginLab'85\User Files\UNTITLED * - /Folderl/ 3
T Import 1 File name: |MEI—R|SE|S-D"0"T |I Add File{s) I 0 [Plot Column  Worksheet  Analysis  Statistics  Image Tools Format  Window Help
- N i L B 1 18

j" Eﬂoo:ne ey Files of type: | “.dat "l |Hem°"’9 F“E[S]| | Cancel | _. & &2 (S |D EHE |sk = |Im 2 ooz | |M| SER ‘m = ‘E-SE- ||§'|
-‘ Target Windoy _IQH&DafaultAvD BT U=x*x, stap X A E~IIl -4~ “ﬁv”v
@]‘ Worksheet -l
k] Template File Name Size Modified i

Temolct= cogy Long Name

Import Mode Comr:er:':t;

— Sparklines
Cancal

Yot Column  Worksheet  Analysis  Statistics Image Tools Format Window Help

BER =&

LR IEERILE

JJ T Default A [0

=l

Long Mame

Units
Comments
Sparklines

0
0.00125
0.0025
0.00375
0.005

DAT

0.00625
0.0075
0.00875
0 01

=1 E==1 ] E=2] L3 1 By R DOV B

3.37838
3.37627
3.36993
3.35038
3.34459
3.32659
3.30236
3.27492
324324
3.20735

Dy METRISEIS I |«

Al

lDOD"-IU!LﬂJhLJM—l

Ly METRIS 1S /—ll <

Duplicate Without Data
Duplicate

Delete
Rename

Maove




1. Apxwa O6ivoupe kKatdAAnAa ovopata
oTLG U0 KOAWVEC ATOTEAECHATWY KOL AV
elvat  duvatov kol povadeg  OTLG

@ OriginPro 8.5 - C\Users\Masterusert| 2 ents\OriginLab'85\User Files\UNTITLED * - /Folder1/ aV'[i_O"[OLXEq vpa“_uéq X
File Edit Vi Plot Column Worksheet Analysis  Statistics  Image | Tools Format  Window Help 2 Z'[r] O'UVEIXEL(I éxovtaq gn[}\gyuévgq '[L(;
sl=-ElL - pgus g4 V| SERE(BE & ABEDs| T 50 G ’ BLLO!
L S i TV Y S S A e oo onlee OV ETUEOmE
Cotumein/Pic s op i et} OVOTIOPOOTHCOULE YPAPLKA, | ix
R Dgﬂf Mutti-Curve I ETUAEYOUE ano v KaPTEAQL
3D XyY L4 « .
oz , Plot—Line—lLine.
+ 3D Surface > 3. e véo mapabupo Onuloupyeital To
, 3D Wire/Bar/Symbol 4 ’ ’ ’
— . ypadnupa. Me katokopudo agova tnv
; Area > TaxVTnTa Kot opllovtio tnv B€on, ylatl
Contour 4 ' ]
- — , oto avtiotoyyo worksheet n koAwva A
T -Stock b elval tng popdng A(x) kot n B(y). Auto
N B Template Library... , , ,
2 EM::IZ:I - av Oev pag PBoAevel pumopel va aAAadel
/‘ < Hine 1 1
- 2 Line + Symbol e Og€l KAk otnv  KOAwva  Kal
) enAéyovtag properties. JuvnOw¢ OpwWG

&

€va apxelo gival ypappévo otnv AoyLKN
X,Y.

4. To ypadpnua mou ¢ TLAXTNKE EXEL TNV
defualt popdry mou bivel to origin, n
omoia wotoco dev eival  mavia
KATAAANAN yla napouciaon
OTIOTEAECUATWV.

< >

Sl B RO D (B B (BB

AU: ON 1: [Book1JMETRISEIS!N[1]:2[41] Radian

: 0 : = . 443PM
H £ Type here to search i A G W@ gz Q) b ENG 37/2021 E,




1. Me Suthd KAk TAvw o€va amnod toug SUo
AfoVEG €XOUE PLa KOPTEAQ OTNV oTola
propoupe va alAafoupe to format twv
@ afovwv. Mo onuavtikn emloyn €ivat n
File )] ' ’
- X Axis - Layer 1 ? w E
y TR e If(lpTEKO( scalle, wWoTE va d)TLOLﬁOIUp.?’E Ta
- Tick Labels Mnor Tick L 4 Custom Tick Labels = opLa Twv aﬁovwv oto embu HNTo EUPOG
7 Scale Title & Format Giid Lines Break y Z~ 15 ) ) )
| Selection: [ \ Kat Bpa (increment). Zto mapAadelypa |y
5 n @ incremert [001 =Er=] NG Suthavng ekOvag KAavape OoAAAyEG
mal O # Major Ticks 7 i . otov opulovtio afova (horizontal), evw
+ OTNn OUVEXELX UMopoUpE va aAAafoupe
EEL = Linear w # Minor Ticks mis ’ ’
s ] To scale emAeyovtag tov katakopudo
cale First Tick 5 ’ . '
% mre [ ] afova (vertical). OAOKANPWVOVTAC TLG
+ m—— ’ ’ ’
3 \ j emOuunteg allayeg, matape ok ko
T ETULOTPEDOUE OTO OPXLKO TTEPLBAAAOV.
. Cancel Apply 2 M 6 )\ ’ )\ ' ' A
| E— : € OUTAO KAKK TAVW OTNV KOUTIUAN
/‘ ' 204 ’ ’ 1
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Paste Link

Paste Link Transpose

Add Text...

Add/Modify Layer Title
Insert Images From Files...
Insert OLE Object

2T ouvéxela pe to Brpa 4 tng dtadavelag 13, slodyoupe
éva akopa worksheet mou mepléxel tnv aplbuntikn Avon,
WOTE VA KAVOUUE OUYKPLoN Twv U0 KOUTUAWY. AWOCOE
KataAAnAa ovopata ot SU0 KOAwVEG, OAAA KoL OTnV
YPOUUR comments Teplypadoupe mola AUon eival. Auto
elval onuoavtiko, ylati oto ypadnua nmouv Ba ¢ptiafoupe to
label kdBe kopmuAng eival ouvdedepévo HE TNV YPOUUN
comments t¢y LETABANTAC.

2tn ouvéxela Kavoupe Ol kALK oTo ypadnua Kol TIOTALE
plot setup.

Av ol kapteAeg bev €xouv avoiel OAeg, matape to PeAakia
ota 6gfld, wote o0To VEO TMapdBupo va PAEMOUUE TPELG
TIEPLOXEG.

Ctrl + V
Cirl + Alt+ V
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Analysis Markers

Show All Data Plots

New Legend
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Copy Format
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Layer Contents...
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Me &€&l KAk oto label kat emiAéyovtac update ,
epudavilouvpe ta label kaBes kapmvAng.

Eniong, pe &gkl KAk oto label kat emAéyovtag
properties, unopovupue va aAAdafoupe to format
(Ttx HéyeBOC YPOUUATOOELPAG KATT).

H oelpd mou eudavilovral ta labels eival n idla
LE QUTA TIOU €lval oL KUTTUAEG otV meptoxn 1y
NG mponyoupevng Stadavelog.

TéAog, umopoUpe To ypadnua mou ¢tiatape va
TO KAVOUUE export oe Ewkova TtUTOU jpg, WOoTE
To eUKoOAQ va UmeL o€ éva apxeio word yla tv
TEALKN TTOLPOUCLAON TWV ATIOTEAECUATWY UTIO TNV
Hopdn texvikng avadopag (report).

Exovtag evepyomolnpévo To TapaBupo Tou
ypadnuatog ETUAEYOUUE File— Export
Graphs—Open Dialogue.

Jto mapdBbupo mou Ba avoiel OSivoupe (a)
KAtdAAnAo oOvopa otnv €wova kat (B) tnv
amobnkelboupe otov emBupntd ¢akelo. O
aA\e¢ emdoyéc adopolv Kuplwg TNV molotnTa
™G ewkovag (ry dpi resolution). Ot default tipég
TOU TPOYPAUHOTOG €lvat  ouvnBwg TmoAU
LKOVOTIOLNTLKEG yLa Ta ypadrpata. TEAOC matapue
ok kal Ba TPEMEL va EXOUUE SNULOUPYNROEL OTOV
avtiotolxo dakelo éva apxeio tng popdng jpg.
AUTO TO apxelo eival mio eVkoAo va yivel otn
ouvéxela Import oe éva apyeio word ywa tnv
Snuwoupyla Tou TeEAKOU report.
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https://visualstudio.microsoft.com/
https://software.intel.com/en-us
https://software.intel.com/en-us/forums/intel-fortran-compiler
https://www.originlab.com/
https://www.originlab.com/doc/Tutorials/Tutorial-GettingStarted

https://stackoverflow.com/
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